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The BUMP Beats curriculum is designed to immerse students in the techniques of modern
computerbased music production. This 18week course guides students through the process of
composing original instrumental music using Propellerhead’s Reason software program.
Throughout the course, students learn fundamental musical concepts, including rhythm and
melody, basic music theory (scales), and song structure. These concepts are introduced
progressively throughout the term in conjunction with the introduction of the various instruments
and tools in Reason. All lessons are designed to provide a maximum amount of handson
learning, supplemented by short lectures and class discussions. By the end of the term,
students are able to produce fulllength songs in a basic popsong structure. In addition to
providing technical training, lessons challenge students to think critically about music and other
forms of media, using relevant contemporary examples for reference.
Unit 1 – Introduction to Rhythm
Week 1  Redrum
Students will be introduced to the concept of computerbased music production and the specific
software being used (Propellerhead’s Reason). Using the manufacturer’s demo song or other
complex piece for reference, an overview of the Reason interface will be given and students will
identify the two main sections: the Instrument Rack and the Sequencer. Students will learn how
use the Create menu to put instruments into the Instrument Rack. Before having the students
start on their projects, the instructor will briefly cover the common types of drum instruments
(focusing on the bass, snare, clap and hi hat), and the roles these instruments play in a typical
beat. Students will then create Redrum drum machines in their projects and start to compose
their own basic (1bar) drum beats using the Step Sequencer on the Redrum drum machine.
For the first project of the week, students will be shown how to load Kits (groups of selected
drum sounds) and place the sounds into a pattern. For subsequent projects, students will be
shown how to search for and load individual drum sounds. They will also learn how to change
the Tempo to adjust the speed of playback and to create multiple patterns using the Pattern
buttons.
Goals
• Becoming familiar with the two main sections of the interface (Instrument Rack & Sequencer)
• Identifying different types of drum instruments (kick, snare, clap, hi hat, etc.) and their roles
in a typical 4/4 drum beat.
• Starting a new Reason session file and creating a Redrum drum machine.

•
•
•
•

Changing the Tempo.
Loading drum sounds (kits and individual sounds) into the Redrum.
Creating a 1 bar (16step) drum pattern using Redrum’s step sequencer.
Changing Patterns.

Lesson 1: Intro to the Redrum Drum Machine (part 1) (PDF)
Lesson 2: Intro to the Redrum Drum Machine (part 2) (PDF)
Lesson 3: Changing Sounds on the Redrum (part 3) (PDF)

Week 2  Redrum
Students will become more familiar with using the Redrum to create drum beats and lay down
the rhythmic foundation of a song. They will learn to setup playback loops using the Loop
Markers in the Sequencer and then transfer the Pattern data into tracks in the main Sequencer
section using the Copy Pattern to Track command (Edit>Copy Pattern to Track). They will also
start to create longer (2bar) patterns using Redrum’s Step Sequencer.
Goals
• Setting up a playback loop in the Sequencer
• Copying patterns to track (Sequencer)
• Creating a 2 bar (32step) drum pattern
• Remake a popular beat (e.g. “A Milli”, “Pop Champagne”, etc.)
Lesson 1: Copying a Redrum Pattern to a Track (“A Milli” remake) (PDF)
Lesson 2: Making a 32step beat (PDF)

Week 3 – Dr. REX
Having gained experience creating basic drum patterns in the previous weeks, students will now
learn to add additional melodic and rhythmic elements to their beats using the Dr. REX loop
player. After being shown how to create a Dr. REX in the instrument rack and load samples into
it, students will learn how to listen to the sounds using the Preview button and transfer the
samples into the Sequencer using the To Track button. Projects for the week will involve
students adding various types of Dr. REX loops (Instrument, Percussion, Hip Hop) to their own
Redrum drum beats.
Goals
• Introduction to the concept of “sampling” and loopbased music
• Types of Dr. REX loops (Instrument, Percussion, Hip Hop)
• Loading and Previewing Dr. REX Loops
• Using To Track to put loops into the Sequencer

Lesson 1: Introducing the Dr. REX (Instrument Loops) (PDF)
Lesson 2: More Dr. REX (Percussion Loops) (PDF)

Week 4 – Dr. REX
Students will continue working with the Dr. REX and learn to use two advanced functions (Pitch
and Tempo) of the instrument to become familiar with modern samplebased production
techniques. Students will gain firsthand experience working with these techniques through
several “remix” projects incorporating sample files from popular pieces of music. The first project
will focus on adjusting the Pitch to alter the overall character of the sample. Subsequent projects
will involve the adjustment of both Pitch and Tempo in order to gain finer control in integrating
samples into compositions.
Goals
• Understanding Pitch and Tempo adjustment
• Changing Pitch and Tempo on the Dr. REX
• Remix Kanye West’s “The Good Life” (using pitchadjusted sample of M.J.’s “PYT”)
• Remix the “Dora the Explorer” theme song (adjust pitch and tempo)
Lesson 1: Dr. REX – Pitch and Tempo (part 1 – “PYT” remix) (PDF)
Lesson 2: Dr. REX  Pitch and Tempo (part 2 – “Dora” remix) (PDF)

Week 5 – Dr. REX
This week, students will learn to use and create with the Dr. REX in a new way via the use of a
MIDI keyboard (Oxygen 8 or equivalent). Students will learn how Dr. REX samples are actually
made up of individual Slices, each of which can be triggered by a key on the keyboard. Projects
throughout the week will involve reconstructing and deconstructing a sample by playing the
slices manually, first in the regular sequence, and then in a different order. The instructor will
also introduce the concept of rhythm and how it works with/differs from melody in music.
Students will learn how to use the Record function in the Sequencer to record their keyboard
performances while playing the slices over their own Redrum drum beats. Emphasis will be on
developing a basic sense of rhythmic timing.
Goals
• Understanding/identifying rhythm
• Connecting a MIDI keyboard to the computer
• Looking at the Dr. REX sample slices in the Edit View of the Sequencer
• Playing slices using the keyboard.
• Using the Record function to record live performances

Lesson 1: Keyboards & Dr. REX (part 1 – playing slices) (PDF)
Lesson 2: Keyboards & Dr. REX (part 2 – play a drum beat “live”) (PDF)

Unit 2 – Introduction to Melody
Week 6  Matrix
Having spent a number of weeks working with premade (i.e. sampled) instrumental elements,
students this week will start to work on creating their own simple melodies using the Matrix Step
Sequencer. After revisiting the concept of melody, students will be shown how to create one
type of melodic instrument (the NN19 sampler) and how to create a Matrix that is connected to
it. Students will then be shown how to adjust the pitch and velocity level (volume) and to arrange
the notes into a melodic sequence. Finally, they will learn how to transfer these melodies into
the main Sequencer using the Copy to Track command. As a first project, students will learn to
program the C Major scale into the sequencer. In introducing the assignment, the instructor will
have students identify the basic qualities of the scale (i.e. happy, upbeat, etc.) and briefly
demonstrate a Minor scale for comparison. Subsequent projects will involve remaking melodies
from popular songs that are in a Major key.
Goals
• Understanding/identifying melody
• Creating an NN19 and Matrix
• Adjusting note information (pitch and velocity) in the Matrix
• Transferring melodies to the Sequencer using Copy To Track
• Becoming familiar with the sound of a Major scale
• Programming the C Major scale into the Matrix
• Remake a popular melody in the key of C Major (e.g. “Rubberband Man”)
Lesson 1: The Matrix & Melody (part 1 – C Major Scale) (PDF)
Lesson 2: The Matrix & Melody (part 2 – “Rubberband Man” remake) (PDF)

Week 7 – Matrix
Building on last week’s introduction, students this week will continue working with the Matrix
Sequencer to create melodies. The focus will be on the Minor scale, which the instructor will
have students learn to identify by sound/”feeling” and distinguish from the feel of the Major
scale. For the first project of the week, students will program the C Minor scale into the Matrix.
Subsequent projects will involve remaking melodies from popular songs that are in a Minor key.
If time permits, the instructor may also show students how to make a Doubletime (“Dirty South”)
style of beat by changing the Resolution setting on the Redrum.

Goals
• Becoming familiar with the sound of a Minor scale
• Programming the C Minor scale into the Matrix
• Remake a popular melody in C Minor (e.g. “Crank Dat”)
• Making a Doubletime Redrum beat
Lesson 1: Matrix & Minor Scale (part 1 – C Minor scale) (PDF)
Lesson 2: Matrix & Minor Scale (part 2 – “Crank Dat Soulja Boy”) (PDF)

Week 8 – Keyboarding/Matrix Con.t'd
Note: Based on the general classroom dynamic and students’ comfort levels with the previous
three weeks of material, the instructor can choose what to cover this week. Option 1 is to have
students start using the MIDI keyboards as their primary melodic tools. Option 2 is for students
to spend another week working with the Matrix Pattern Sequencer, learning some of the more
advanced functions.
Option 1
Students will start working with the MIDI keyboards to create simple melodies and learn some
basic music theory. The first class session of the week will focus on learning the names of the
white keys and playing the C Major scale. The instructor will explain the concept of a scale (sets
of notes that sound good together) and the reasons that musicians use them when composing.
Students will be given keyboard reference worksheets (to be collected at the end of class and
used for reference in subsequent classes) in which they will label the white keys. Students
should already be familiar from previous weeks with the general sound of the Major scale and
will now make the connection to the physical act of playing it, using only the white keys. They
will be shown the proper hand technique for playing a scale up and back and also how to turn
on the Click (metronome). Students will then practice playing the scale to the Click, adjusting it
to a comfortable tempo and, when ready, record themselves playing. Subsequent assignments
for the week will involve students playing simple Majorkey melodies using specific white keys
(specified by the instructor) over their own drum beats and getting more comfortable with
playing.
Goals
• Naming the white keys of the keyboard
• Turning the Click on/off
• Playing in time with the Click
• Playing a scale (hand technique)
• Recording the C Major scale
• Recording a simple, original melody in C Major

Option 2
This week, students will learn to create longer (2bar) melodies with the Matrix sequencer.
Students will use the Octave switch to change the pitch range of the notes they are working with
and the Pattern buttons to create multiple sequences which can then be combined in the main
Sequencer as a single, longer melody. The second project will involve the students creating the
same melody in two different pitches.
Goals
• Changing octaves
• Using multiple patterns
• Creating 2octave melodies
• Remaking “Snap Ya Fingers” melody (Lil’ John”)
• Making an original 2octave melody using the “Snap Ya Fingers” model
Lesson 1: Basic Keyboarding (part 1 Naming the white keys) (PDF)
Lesson 2: Basic Keyboarding (part 2 – Working in C Major) (PDF)

Week 9 – Keyboarding
Students this week will learn the names of the black keys on the keyboard and will be
introduced to the concept of sharps and flats. Using the worksheet from the previous week,
students will label each of the black keys with both the sharp and flat names. (This worksheet
will continue to be used as a reference aid and should be collected at the end of each class.)
For the first project, students will make an original melody over their own beats using only the
black keys (pentatonic scale). In the following class, students will learn the Major scale formula
(WWHWWWH) and figure out the notes of the G Major scale, marking them on a new
worksheet. For the day’s project, they will create an original melody over their own beats using
only keys from G Major.
Goals
• Naming the black keys
• Understanding sharps and flats
• Learning the Major Scale Formula
• Creating an original melody in G Major
Lesson 1: Basic Keyboarding (part 3 – Black keys) (PDF)
Lesson 2: Basic Keyboarding (part 4 – G Major Scale) (PDF)

Week 10 – Keyboarding
Students will learn and start working with the Minor scale. The instructor will first introduce the
Minor scale formula (WHWWHWW). Using their keyboard worksheets for reference,
students will figure out the notes of the C Minor scale and mark them on a second worksheet.
Students will then practice playing the scale to the Click (metronome), adjusting it to a
comfortable tempo and, when ready, record themselves playing. Subsequent assignments for
the week will involve students playing simple Minorkey melodies using specific keys (specified
by the instructor) over their own drum beats and getting more comfortable with playing.
Advanced students should be encouraged to figure out and compose using a Minor scale other
than C (e.g. D).
Goals
• Learning the Minor scale formula
• Recording the C Minor scale
• Recording simple original melodies in C Minor and/or other minor keys
Lesson 1: Minor Scale (PDF)
Lesson 2: C Minor Melody (PDF)

Unit 3 – Song Structure
Week 11 – Song Structure pt. 1 (Full Song 1)
Having spent 10 weeks learning the functions of Reason, developing keyboarding skills and
becoming familiar with some basic music theory, students should now be ready to start
producing longer, more structured pieces – songs!. This week will focus on the two main
sections of a typical “pop” song: the Verse and the Chorus. The instructor will first explain what
these two elements are, their roles in a song, the creation of dynamic flow, etc. The class then
will listen to segments of several popular songs and identify the Verse and Chorus in each. As a
first assignment, students will start to create a simple Verse section for their own original song,
including a drum beat and several melodic instruments. The instructor will also show them how
to Copy and Paste note regions in the Sequencer so that students can extend their loops to the
length of a standard verse (16 bars). In the second class, students will work on a Chorus
section.
• Identifying Verses
• Identifying Choruses (“hooks”)
• Copying and Pasting in the Sequencer
• Creating an original Verse/Chorus structure
Lesson 1: Song Structure (part 1 – Verses & Choruses)(PDF)

Lesson 2: Song Structure (part 2 – Verses & Choruses) (PDF)
Week 12 – Song Structure pt. 2 (Full Song 1)
This week, students will continue working on their Verse/Chorus projects from the previous
week. By the end of the week, every student should have at least a
VerseChorusVerseChorus format for his/her song. The instructor will also take some time to
briefly explain two more elements of song structure, the Intro and the Bridge, and play examples
from a popular song. Most students will probably still need time to finish the Verses and
Choruses from the previous week and may not get to the Intro/Bridge, so the instructor can
decide whether or not to require these additional segments or, perhaps, to give extra credit for
students finish early and have time to work them into their pieces. Instructor should also make
sure every student knows how to copy and paste entire sections of a song together (rather than
one instrument at a time).
Goals
• Identifying Intros
• Identifying Bridges
• Copying and pasting regions using ALT/OPTIONdrag
• Completing a song with at minimum a basic VerseChorusVerseChorusVerseChorus
structure
Lesson 1: Song Structure/Full Song 1 (part 1  Intro & Bridge) (PDF)
Lesson 2: Song Structure/Full Song 1 (part 2  Bridge) (PDF)

Week 13 – Full Song 2
This week, students will begin working on their second full song, again following a pop song
structure (IntroVerseChorusVerseChorus). Students at this point should have enough
experience to largely work independently. At the beginning of each class, the instructor might
have students listen critically to a few examples of popular songs and facilitate class discussion
around the techniques artists use to build their music. The project for this week will also require
the inclusion of an Intro section. Lectures for Weeks 1314 should be minimal, as the majority of
the time should be designated for the students to work on their songs. Oneonone instruction
should be provided as needed to address specific challenges that students are facing.
Goals
• Creating a 16bar Verse section (drum beat and melody)
• Creating an 8bar Chorus (drum beat and melody)
• Creating an Intro section
• Copying and pasting to create 2 Verses, 2 Choruses

Lesson 1: Full Song 2 (pt. 1) (PDF)
Lesson 2: Full Song 2 (pt. 2) (PDF)
Week 14 – Full Song 2
Students will finish working on their songs from the previous week. At the beginning of the
week, the instructor should play at least one example of a song that showcases a strong
dynamic shift between the Verse and the Chorus sections. Students will identify the instrumental
elements that create this shift. Goals for this week will be a) the inclusion of more
instruments/sounds to enhance the dynamic flow of their songs (cymbals, bass sounds, pads,
etc.). Students who finish quickly can be encouraged to also add a Bridge, or be shown
individually how to apply more advanced production techniques, such as “drop outs”, instrument
layering, or FX. By the end of the week, all students should turn in a song that has an
IntroVerseChorusVerseChorus structure.
Goals
• Adding dynamic instrumentation
• Adding an Intro section
• Completing in a full song
Lesson 1: Full Song 2 (pt. 3) (PDF)
Lesson 2: Full Song 2 (pt. 4) (PDF)

Unit 4 – Advanced Applications
Week 15 – Mixing
(Note: This week has 3 Lessons available from which the instructor can choose the most
relevant topics)
This week, students will shift their attention to the process and tools of mixing. The instructor will
explain what mixing is and how it can affect the final musical product. The lesson will focus on
volume and panning adjustments in the Mixer. Students will open their songs from the previous
week and spend time adjusting these two elements. As a second lesson, the instructor can
demonstrate how to create a fade out at the end of a song by automating the Master fader on
the Mixer. Students will then add fade outs to their own pieces. The rest of the week can be
dedicated to becoming familiar with different types of FX. Students will be shown how to attach
a dedicated FX unit to any of the instruments in the rack. Special attention should be given to
the RV7000 Reverb and Scream Distortion units, as reverb and distortion are two of the most
commonly used studio FX processors. Students can then spend time adding FX to their existing
beats, or creating new beats in which they can experiment with different FX.
Goals
• Balancing tracks using (volume and panning)

•
•

Creating fade outs
Using FX processors (reverb, distortion, etc.)

Lesson 1: Mixing (part 1 – Volume & Panning) (PDF)
Lesson 2: Mixing (part 2 – Using FX) (PDF)
Lesson 3: Mixing (part 3 – Fade Outs) (PDF)

Week 16 – Full Song 3 – Acapella Remix
For the last two weeks of the term, students will work on their third and final song project. This
project will incorporate the use of an “acapella” vocal track from a popular song. The acapella
will be divided into a series of audio files, each containing a specific section of the song (Verse
1, Verse 2, Chorus, etc.). Students will be shown how to load these audio files into the NN19
sampler and trigger them to play back for the entire duration of the song section by drawing
notes in the Edit View of the Sequencer using the Pencil Tool. After first adjusting the song to
the appropriate tempo, the students will then create an original beat to go under the acapella.
Before saving and closing their projects at the end of the first class, students will use the Song
SelfContain Settings command (File>Song SelfContain Settings) to lock the audio files into the
project file.
Goals
• Loading and playing back audio files using the NN19
• Using the Pencil Tool in the Edit View
• Using the Song SelfContain Settings command
• “Remixing” a popular song using an acapella
Lesson 1: “Tell Me When To Go” Acapella Remix (pt. 1  Hook) (PDF)
Lesson 2: “Tell Me When To Go” Acapella Remix (pt. 2  Verse) (PDF)

Week 17 – Full Song 3 – Acapella Remix
Students will continue working to complete their Acapella Remix projects from the previous
week. They should continue to build the song, section by section, importing the individual audio
files as they go. The instructor should remind students to always use the Song Self Contain
Settings command at the end of each class to insure that the audio files are locked into the
project file. In addition, the instructor should review the process of creating Fade Outs at the end
of songs so that all students are able to apply them to their projects.
Goals
• Reviewing creating Fade Outs
• Completing Acapella Remixes

Lesson 1: “Tell Me When To Go” Acapella Remix (pt. 3 – Copy Verse/Chorus) (PDF)
Lesson 2: “Tell Me When To Go” Acapella Remix (pt. 4 – mixing, finishing up) (PDF)

Week 18 – Exporting Audio and Final Review
For the final week of instruction, students will learn how to convert the music they have created
in Reason into audio files that they can take home and listen to using standard audio players
(iTunes, CD, etc.). They will first be shown how to use the Export Audio File command
(File>Export Audio File) to create WAV/AIF files of their songs. The instructor will then
demonstrate the process for importing the files into a standard audio software player (e.g.
iTunes, Windows Media Player, etc.). From within the audio software, students will learn how to
convert their files to a compressed MP3 format and create Playlists to organize their music.
Finally, students will be shown how to burn CDs of their work and/or email files to themselves.
If the instructor chooses to give a Final Exam to the class, a review should be provided
beforehand.
Goals
• Exporting Audio Files from Reason
• Importing files into audio playback software
• Burning CDs
• Converting AIF/WAV files to MP3s
• Emailing MP3s to self
• Reviewing for Final Exam
Lesson 1: Exporting Audio Files from Reason (PDF)
Lesson 2: Burning CDs (PDF)

